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INCLUDED BUTTONS

A. Duo™ Underwater MP3 Player A. On/Off/Play/Pause

B. USB Magnetic Dock B. Replay Current Song/Backward/Volume Up

C. Quickstart Guide C. Advance/Volume Down

D. Random Play On/Random Play Off
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HOW T0 WEAR

A. Use (left side) and (right side) on the back of each
speaker to orient correctly

B. Slide goggle straps through the brackets on each side

C. Place the bone conduction speakers to rest upon
temple bone, not over ear, for optimal clarity

Duo™ is best heard underwater or with earplugs to block
atmospheric noise




HOW TO USE: PLAYING MUSIC

A. ON/OFF

To turn Duo™ ON: Press and hold the center button
for 3 seconds The solid GREEN light indicates that
playback will begin in 10 seconds

To turn Duo™ OFF: Press and hold the center
button for 3 seconds. The blinking GREEN light
indicates that the device is turning off

B. PLAY/PAUSE

To PLAY music: Single press the center button
Songs will play in the order in which they were
uploaded from your computer

While playing music, the GREEN Llight blinks once
every 3 seconds

To PAUSE music: Single press the center button
While paused, the GREEN light blinks twice every 3
seconds

C. ADVANCE/VOLUME DOWN

To ADVANCE: Single press the button to play next
song(s)

To VOLUME DOWN: Press and hold the button to
decrease volume

The GREEN Llight will blink while decreasing volume,

until button is released and desired volume is
reached

D. REPLAY/BACKWARD/VOLUME UP

To REPLAY the current song: Single press the button
To go BACKWARD: Double press the button to play
previous song(s)

To VOLUME UP: Press and hold the button to
increase volume

The GREEN light will blink while increasing volume,
until button is released and desired volume is reached

E. RANDOM PLAY

To turn Random Play ON: Press and hold the button.
The solid GREEN light will appear for 1 second to
indicate Random Play mode is ON

To turn Random Play OFF: Press and hold the button.
The blinking GREEN light indicates Random Play
mode is OFF




HOW T0 USE: CHARGING

B.

C.

e Duo™ takes 3 hours to charge from low to full*

e Play time is up to 7 hours, depending on settings and
volume level

¢ To CHARGE: First, locate the gold connectors on the
back of the (left side) speaker

e Align the connectors with the pins on the USB
magnetic dock

e Directly connect the USB into your computer’s USB
port (your computer will automatically recognize the
device)

. The blinking GREEN light indicates charging (3 hours to

charge from low to full)
The solid GREEN indicates a full charge

The RED light indicates low battery**

*Please charge your Duo™ for 24 hours before first use
**Will turn off automatically if battery is depleted is OFF




HOW T0 USE: LOADING MUSIC

Storage capacity is 4GB (about 1000 songs)
Directly connect the USB into your computer’'s USB
port (your computer will automatically recognize
the device)

Confirm that all desired songs were loaded by
opening the FINIS Duo™ drive

Any unsupported audio files in the FINIS Duo™ drive
will not play on the device

To DELETE songs, open the FINIS Duo™ drive and
delete desired songs by right clicking or pressing
“delete” key on keyboard

A. LOADING FOR WINDOWS® USERS:

Open the FINIS Duo™ drive

Location: "My Computer”

Open any folder on your computer that contains MP3
and WMA music formats

Drag and drop music files into the FINIS Duo™ drive,

status bar will appear while loading

B. UPLOADING THROUGH WINDOWS
MEDIA PLAYER®:

Open Windows Media Player music library
FINIS Duo™ drive will automatically appear in the
Sync tab

Drag and drop music files into the FINIS Duo™ drive,

status bar will appear while loading

Press ‘Start Sync’ when ready to upload

Using Windows Media Player will create an .xml
document for all uploaded songs. Do NOT delete the
.xml document unless you are removing all songs

C. LOADING FOR MAC® USERS:

Open the FINIS Duo™ drive

Location: "Desktop”

Open any folder on your computer that contains MP3
and WMA music formats

Drag and drop music files into the FINIS Duo™ drive,
status bar will appear while loading




HOW T0 USE: SUPPORTED AUDIO FILES

HOW TO USE: SAFE REMOVAL

Non-protected MP3 and WMA files

AAC and Purchased AAC files must be converted to
an MP3 format

Audio book files must be in MP3 format

HOW TO USE: UNSUPPORTED AUDIO FILES

Protected MP3, AAC and WMA are not supported
or playable

Audible® book downloads are not supported

or playable

IMPORTANT: CORRUPT FILE PREVENTION

MP3 files must be greater than 1000 KB

Must upload native files from storage device or

media management software (do not upload song

shortcuts)

e Please note: Uploading unsupported files can lead
to freezing of unit, battery depletion or a decrease
in device lifespan

A.FOR WINDOWS® USERS:

Locate the FINIS Duo™ drive
Location: "My Computer”
Right Click and select “Eject”

B. FOR MAC® USERS:

Locate the FINIS Duo™ drive

Location: “Desktop”

Drag and drop the FINIS Duo™ drive icon from
desktop to Trash or Ctrl+click and select Eject
“FINIS Duo™”




HOW TO USE: CONVERTING FILE TYPE

A.

B.

Open iTunes Preferences.
e Windows: Choose Edit > Preferences
e Mac: Choose iTunes > Preferences

Click the General button, then click the Importing
Settings... button in the lower section of the window

. From the Import Using pop-up menu, choose the MP3

encoding format, then click OK to save the settings

. Select one or more songs in your library, right click or

from the File > Create New Version menu, choose one
of the following (the menu item changes to show what's
selected in your Importing preferences):

e Create MP3 version

Note: Older purchased songs are encoded using a
Protected AAC format that prevents them from being
converted. To convert these to another format, visit:
https://support.apple.com/en-us/HT201616.

The song in its original format and the newly converted
song appear in your library.

Information sourced from:
https://support.apple.com/en-gb/HT204310



CARE INSTRUCTIONS

SYSTEM REQUIREMENTS

Duo™ is waterproof up to 3 meters - safe to use in
swimming pools, lakes, oceans or any bodies

of water

Rinse with fresh water after use

Pat dry, and store in a cool, dry environment

Do not place in direct sunlight to dry as this may
cause damage

Do not use sharp objects, such as fingernails, to
depress buttons as this could puncture surface and
lead to water damage

Do not attempt to charge or connect while wet, USB
Magnetic Dock is not waterproof

Recommended: Keep the charging pins clean by
using a soft cotton swab and rubbing alcohol

IMPORTANT! Routine Maintenance

A. After each use, rinse with fresh water, pat dry and store in a

cool, dry environment
B. Clean gold connectors on back of device by using a soft
cotton swab or toothbrush and rubbing alcohol

a. Please note: Failure to dry and clean device
regularly can lead to corrosion, which may
compromise functionality

e Pentium®lIll 500 MHz or higher recommended
e Windows XP®(service pack 1 or higher] or

e Windows Vista®Windows 7®

e Windows 8®

e Mac®0S9Xor higher

e 250 MB available hard drive space

e 128 MB RAM (256 recommended)

e USB Port (2.0 recommended)

e Internet access (recommended)

¢ Sound Card (recommended)




WARRANTY

One Year Limited Warranty: The Duo™ Underwater MP3
Player is warranted by FINIS to be free of defects in
materials of workmanship, under normal use, for 1 year
from the purchase date of original device. The limited
warranty excludes damage resulting from improper care of
handling, accidents, modifications, unauthorized repairs,
normal wear or other causes which are not defects in
materials and workmanship. If there is a covered defect,
we will repair or replace the product free of charge or
issue a refund at FINIS" discretion. Proof of purchase
required.

Please visit www.FINISinc.com/support for
more information.
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INHALT TASTEN

A. Duo™ MP3-Player zum Unterwassergebrauch A. An/Aus/Play/Pause

B. USB-Anschluss mit Magnet-Halt B. Derzeitiges Lied erneut spielen/Zurick/
Lautstarke erhohen

C. Anleitungen zum Schnellstart

C. Vorwarts/Lautstarke vermindern

D. Zufallsabspieler ein/ Zufallsabspieler aus

A. / ,—\/\v C.
— RN —
< )
3
duo
AR P LR B D.
dJ

QUICKSTART GUIDE
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TRAGWEISE

A. Halten Sie sich an (links) und (rechts) auf der Rickseite
der Lautsprecher zur korrekten Orientierung

B. Ziehen Sie die Schlaufen der Schwimmbrille durch die
Klammer auf beiden Seiten

C. Setzten Sie fur optimale Klarheit die
Knochenleitkopfhorer an der Schlafe, nicht an den
Ohren, an

Duo™ ist unter Wasser am besten mit Ohrstépseln zum
Abblocken atmospharischen Rauschens zu horen
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BENUTZUNG: ABSPIELEN VON MUSIK

A. AN/AUS

Zum Anschalten von Duo™: Halten Sie die mittlere
Taste 3 Sekunden lang gedriickt Das einfarbige
GRUNE Licht zeigt an, dass die Wiedergabe in 10
Sekunden beginnt

Zum Abschalten von Duo™: Halten Sie die mittlere
Taste 3 Sekunden lang gedriickt. Das blinkende
GRUNE Licht zeigt an, dass das Gerat sich
ausschaltet

B. PLAY/PAUSE

Zum Abspielen von Musik: Driicken Sie kurz die
mittlere Taste

Die Lieder werden in der Reihenfolge abgespielt, in
der sie von lhrem Computer heruntergeladen wurden
Wahrend des Abspielens blinkt das GRUNE Licht alle
3 Sekunden

Zum Anhalten der Musik: Driicken Sie kurz die
mittlere Taste

In angehaltenem Zustand blinkt das GRUNE Licht
alle 3 Sekunden

C. VORWARTS/LAUTSTARKE VERMINDERN

Vorwarts: Dricken Sie kurz die Taste zum Abspielen
dernachsten Lieder

Zur Verminderung der Lautstarke: Halten Sie die
mittlere Taste zur Verminderung der Lautstarke
gedriickt

Das GRUNE Licht blinkt bei der Verminderung

der Lautstarke bis zum Loslassen der Taste bei
Erreichen der gewilinschten Lautstarke

D. ERNEUTES ABSPIELEN/ZURUCK/
LAUTSTARKE ERHOHEN

Zum erneuten Abspielen des derzeitigen Liedes:
Driicken Sie kurz die Taste

Zuriickgehen: Driicken Sie zweimal die Taste zum
Abspielen vorheriger Lieder

Lautstarke erhchen: Halten Sie die Taste zum
Erhohen der Lautstarke gedriickt

Das GRUNE Licht blinkt bei der Erhéhung der
Lautstarke bis zum Loslassen der Taste bei
Erreichen der gewilinschten Lautstarke

E. ZUFALLSWIEDERGABE

Einschalten der Zufallswiedergabe: Halten Sie die
Taste gedriickt. Das einfarbige GRUNE Licht scheint
zum Anzeigen der Zufallswiedergabe 1 Sekunde lang
Abschalten der Zufallswiedergabe: Halten Sie die
Taste gedriickt. Das blinkende GRUNE Licht zeigt
das Ausschalten der Zufallswiedergabe an

4
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BENUTZUNG: AUFLADEN

e Duo™ ladt sich in 3 Stunden von niedrigem zu vollem A.
Akkustand auf*

e Der Akku halt bis zu 7 Stunden, je nach
Einstellungen und Lautstarkepegel

e Aufladen: Sehen Sie zunachst die goldfarbenen
Anschlisse auf der Riickseite des (linken)
Lautsprechers

e SchlieBen Sie die Anschliisse an die Kontakte auf
dem USB-Anschluss an

e Verbinden Sie den USB-Stick direkt mit dem USB-
Anschluss Ihres Computers (lhr Computer erkennt
das Gerat automatisch)

A. Das blinkende GRUNE Licht zeigt das Aufladen (3
Stunden von niedrigem bis zu vollem Akkustand)

B. Das einfarbige GRUNE Licht zeigt vollen Akkustand an

C. Das ROTE Licht zeigt niedrigen Akkustand an**

* Laden Sie bitte Ihr Duo™ vor dem ersten Gebrauch
wahrend 24 Stunden auf

** Das Gerat schaltet sich bei aufgebrauchtem Akku
automatisch aus
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BENUTZUNG: LADEN VON MUSIK

Die Speicherkapazitat betragt 4GB (etwa

1000 Lieder)

Verbinden Sie den USB-Stick direkt mit dem USB-
Anschluss Ihres Computers (lhr Computer erkennt
das Gerat automatisch)

Bestatigen Sie das vollstandige Laden aller
gewiinschten Lieder durch Offnen des FINIS
Duo™-Laufwerks

Alle nicht unterstiitzten Audio-Dateien im FINIS
Duo™-Laufwerk werden vom Gerat nicht abgespielt
Zum Loschen von Liedern 6ffnen Sie das FINIS
Duo™-Laufwerk und l6schen die jeweiligen Lieder
durch Driicken rechts oder der “Léschen”-Taste auf
der Tastatur

A. LADEN FUR BENUTZER VON WINDOWS®:

Offnen Sie das FINIS Duo™-Laufwerk

Ort: “Computer”

Offnen Sie alle Ordner auf lhrem Computer, welche
MP3- und WMA-Musikformate beinhalten

Wenden Sie Ziehen und Loslassen an, um die
Musik-Dateien in das FINIS Duo™-Laufwerk zu
stellen; wahrend des Ladevorgangs erscheint eine
Statusleiste

B. ADEN DURCH DEN WINDOWS MEDIA PLAYER®:

Offnen Sie die Musik-Bibliothek des Windows
Media Player

Das FINIS Duo™-Laufwerk erscheint automatisch im

Synchronisierungs-Tab

Wenden Sie Ziehen und Loslassen an, um die Musik-

Dateien in das FINIS Duo™-Laufwerk zu stellen;
wdhrend des Ladevorgangs erscheint
eine Statusleiste

Driicken Sie “Synchronisierung beginnen”, um den
Ladevorgang zu beginnen

Der Windows Media Player erstellt ein .xml-
Dokument fiir alle geladenen Lieder. Loschen Sie
das .xml-Dokument NICHT, sonst werden alle
Lieder entfernt

C. LADEN FUR BENUTZER VONMAC®:

Offnen Sie das FINIS Duo™-Laufwerk

Ort: “Desktop”

Offnen Sie alle Ordner auf lhrem Computer, welche
MP3- und WMA-Musikformate beinhalten

Wenden Sie Ziehen und Loslassen an, um die
Musik-Dateien in das FINIS Duo™-Laufwerk zu
stellen; wahrend des Ladevorgangs erscheint eine
Statusleiste
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BENUTZUNG: UNTERSTUTZTE AUDIO-DATEIEN BENUTZUNG: SICHERES ENTFERNEN

e Ungeschitzte MP3- und WMA-Dateien A.FUR BENUTZER VON WINDOWS®:

e AAC- und erworbene AAC-Dateien miissen in MP3- e Gehen Sie zum FINIS Duo™-Laufwerk
Format konvertiert werden e Ort: “Computer”

e Ausfiihrliche Anleitungen zur Konvertierung in MP3- ¢ Klicken Sie rechts und wéhlen Sie “Auswerfen”
Format finden Sie auf www.FINISinc.com/Duo™

e Horblcher missen MP3-Format haben B. FUR BENUTZER VON MAC®:

e Gehen Sie zum FINIS Duo™-Laufwerk
e Ort: “Desktop”

BENUTZUNG NICHT UNTERSTUTZTE AUD|U'DATE|EN e Wenden Sie Ziehen und Loslassen an, um das Icon

des FINIS Duo™-Laufwerks vom Desktop zum
e Geschitzte MP3, AAC und WMA werden nicht Papierkorb zu bewegen, oder Ctrl+click und wéhlen

unterstitzt und sind nicht abspielbar Sie “FINIS Duo™ auswerfen”
e Heruntergeladene Biicher von Audible® werden
nicht unterstiitzt und sind nicht abspielbar

WICHTIG: VORBEUGUNG VON DATEIBESCHADIGUNG
e MP3-Dateien missen grofier als 1000 KB sein
e Es missen urspriingliche Dateien vom Speichergerat
oder der Medienverwaltungs-Software hochgeladen
werden (laden Sie keine Verkniipfungen hoch)
e Bitte beachten: Das Hochladen nicht
unterstitzter Dateien kann das Einfrieren des
Gerats, Batterieerschopfung oder eine geringere
Lebensdauer zur Folge haben
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BENUTZUNG: KONVERTIEREN VON DATEITYP

A.

B.

C.

D.

52

Benutzung: Konvertieren von Dateityp.
e Windows: Wahlen Sie Bearbeitungs > Einstellungen
e Mac: Wahlen Sie iTunes > Einstellungen

Windows: Wahlen Sie Bearbeitungs > Einstellungen.
Mac: Wahlen Sie iTunes > Einstellungen

Windows: Wahlen Sie Bearbeitungs > Einstellungen.
Mac: Wahlen Sie iTunes > Einstellungen

Wahlen Sie durch Klick rechts oder aus dem Meni
Datei > Neue Version erstellen ein oder mehrere Lieder
aus lhrer Mediathek aus. Wahlen Sie darauf eine der
folgenden Optionen (der Menii-Gegenstand andert sich
und zeigt an, was Sie in lhren Import-Einstellungen
ausgewahlt haben):

e MP3-Version erstellen

Hinweis: Altere erworbene Lieder sind mit einem
geschitzuten AAC-Format kodiert, welches die
Konvertierung verhindert. Um solche zu konvertieren,
besuchen Sie bitte unsere Website:
https://support.apple.com/en-us/HT201616.

Das Lied in seinem Originalformat und das neu-
konvertierte Lied erscheinen in Ihrer Mediathek

Quelle der Informationen:
https://support.apple.com/en-gb/HT204310
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SYSTEMANFORDERUNGEN

Duo™ ist wasserfest fur Tiefen bis zu 3 Metern -
zum sicheren Gebrauch in Schwimmbecken, Seen,
im Meer oder anderen Gewassern

Spilen Sie das Gerat nach Gebrauch mit
Frischwasser ab

Klopfen Sie es zum Trockenen leicht ab und
bewahren Sie es in einer kithlen und trockenen
Umgebung auf

Setzten Sie das Gerat zur Vermeidung von Schaden
nicht zum Trocknen unmittelbar dem Sonnenlicht
aus

Benutzen Sie keine scharfen Objekte wie
Fingerndgel zum Driicken der Tasten; diese kdnnen
die Oberflache durchstechen und Wasserschaden
verursachen

Versuchen Sie nicht, das noch nasse Gerat zu laden
oder anszuschlieen; der USB-Anschluss ist nicht
wasserfest

Empfehlung: Halten Sie die Ladeanschliisse durch
ein weiches Wattestabchen und Einreiben von
Alkohol sauber

WICHTIG! RegelmaBige Wartung

A. Spilen Sie das Gerat nach jedem Gebrauch mit frischem
Wasser ab, trocknen Sie es und bewahren Sie es an einem

kihlen und trockenen Ort auf

B. Reinigen Sie die Gold-Anschlisse auf der Rickseite des
Gerats mit einem weichen Baumwoll-Tuch oder einer
Zahnbirste und Reinigungsalkohol

a. Bitte beachten: Nicht regelmaBig erfolgendes
Trocknen und Reinigung kann Korrosion zur Folge
haben und die Funktion beeintrachtigen

Pentium®IIl 500 MHz oder mehr Lesitungsfahigkeit
wird empfohlen

Windows XP® (Service-Pack 1 oder héhere Stufe)
oder

Windows Vista® Windows 7®

Windows 8®

Mac®0S9X oder hohere Stufe

250 MB Festplattenspeicher zur Verfligung

128 MB RAM (256 empfohlen) o USB-Anschluss (2.0
empfohlen)

Internetanschluss (empfohlen)

Sound-Karte (empfohlen)
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GARANTIE

Ein Jahr Garantie: FINIS garantiert, dass der Duo™
MP3-Player zum Unterwassergebrauch keine Defekte an
Material oder durch die Verarbeitung hat. Diese Garantie
gilt bei bestimmungsgemaBem Gebrauch und wahrend
eines Jahres nach Kauf des Originalgerats. Die befristete
Garantie gilt nicht bei Schaden aufgrund mangelnder
Sorgfalt oder unsachgemafier Handhabung, Unfallen,
Veranderungen, eigenmachtigen Reparaturen, normaler
Abnutzung oder anderen Ursachen, welche keine Defekte
an Material oder durch die Verarbeitung darstellen. Im
Falle eines von der Garantie gedeckten Defekts reparieren
oder ersetzen wir das Produkt kostenlos oder erstatten
den Preis auf Kosten von FINIS. Ein Kaufnachweis

wird erwartet.

Weitere Informationen finden Sie auf
www.FINISinc.com/support.
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CE QUI EST INCLUS BOUTONS

A. Lecteur MP3 subaquatique Duo™ A. Allumé/Eteint/Lecture/Pause

B. Dock magnétique USB B. Répéter morceau en cours/Aller en arriére/
Augmentation volume

C. Guide de démarrage rapide

C. Aller en avant/Réduction volume

D. Lecture aléatoire activée/désactivée

A. / ,—\/\v C.
— RN —
< )
3
duo
AR P LR B D.
dJ

QUICKSTART GUIDE
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COMMENT PORTER

A. Utiliser les marquages (c6té gauche) et (coté droit) sur La meilleure facon d'écouter le systéme Duo™ est sous
le dos des écouteurs pour une orientation correcte l'eau ou avec des bouchons d’oreilles pour bloquer les
bruits atmosphériques

B. Glisser les sangles a travers les supports de
chaque coté C.

C. Mettre les écouteurs a conduction osseuse sur la
tempe, pas dans loreille, pour une clarté optimale
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COMMENT UTILISER: ECOUTER LA MUSIQUE

D. REPETER/ALLER EN ARRIERE/
AUGMENTATION VOLUME
e Pour REPETER le morceau en cours : Appuyer

A. ALLUME/ETEINT
e Pour allumer le systeme Duo™ : Appuyer et
maintenir le bouton central pendant 3 secondes.

La lumiére VERTE continue montre que la lecture
commence dans 10 secondes

Pour éteindre le systéme Duo™ : Appuyer et
maintenir le bouton central pendant 3 secondes. La
lumiere VERTE intermittente montre que le dispositif
est en train de s'éteindre

B. LECTURE/PAUSE

Pour commencer la LECTURE : Appuyer le bouton
central

Les morceaux seront lus dans l'ordre de
téléchargement de l'ordinateur

Pendant la lecture, la lumiére VERTE clignote toutes
les 3 secondes

Pour mettre PAUSE : Appuyer le bouton central
Pendant la pause, la lumiere VERTE clignote deux
fois toutes les 3 secondes

C. ALLER EN AVANT/REDUCTION VOLUME

Pour AVANCER : Appuyer le bouton pour aller au(x]
morceau(x) suivant(s)

Pour REDUIRE LE VOLUME : Appuyer et maintenir le
bouton

La lumiére VERTE clignote pendant la réduction du
volume, jusqu’a ce que le bouton soit relaché et que
le volume désiré soit atteint

le bouton

Pour aller EN ARRIERE : Appuyer deux fois le bouton
pour lire le(s) morceaul(x) précédent(s)

Pour AUGMENTER LE VOLUME : Appuyer et
maintenir le bouton

La lumiéere VERTE clignote pendant l'augmentation
du volume, jusqu’a ce que le bouton soit relaché et
que le volume désiré soit atteint

E. LECTURE ALEATOIRE

Pour ACTIVER la lecture aléatoire : Appuyer et
maintenir le bouton La lumiére VERTE continue
s'allume pendant 1 seconde pour montrer que le
mode de Lecture Aléatoire est ACTIVE

Pour DESACTIVER la lecture aléatoire : Appuyer et
maintenir le bouton. La lumiére VERTE clignote pour
montrer que le mode de Lecture Aléatoire

est DESACTIVE
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COMMENT UTILISER: CHARGEMENT

e Le chargement complet* du systeme Duo™ dure 3 A.
heures

e Ladurée de lecture est de 7 heures, en fonction des
réglages et du niveau du volume

e Pour CHARGER : Premiérement, localiser les
connecteurs dorés sur le dos de l'écouteur (coté
gauche)

e Aligner les connecteurs avec les fiches du dock
magnétique USB

e Connecter le cable USB directement a votre
ordinateur (U'ordinateur reconnait le dispositif
automatiquement)

B.

A. La lumiére VERTE clignotante indique le chargement (3

heures pour un chargement complet)
B. La lumiére VERTE continue indique un

chargement complet
C. La lumiére ROUGE indique un niveau réduit de

la batterie**
* Veuillez charger votre Duo™ pendant 24 heures avant la
premiére utilisation
** | e dispositif s"éteint automatiquement si la batterie est C.

déchargée
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COMMENT UTILISER: COPIER LA MUSIQUE

La capacité de stockage est de 4GO (environ

1000 morceaux)

Connecter le cable USB directement a votre
ordinateur (l'ordinateur reconnait le dispositif
automatiquement)

Confirmer si tous les morceaux ont été copiés en
ouvrant lunité FINIS Duo™

Les fichiers incompatibles qui se trouvent sur l'unité
FINIS Duo™ ne seront pas lus

Pour EFFACER les morceaux, ouvrir U'unité FINIS
Duo™ et effacer en cliquant droit ou a l'aide de la
touche « effacer » sur le clavier

. COPIER POUR LES UTILISATEURS WINDOWS®:

Ouvrir Uunité FINIS Duo™

Lieu : « Mon Ordinateur »

Ouvrir tout directeur contenant des fichiers au
format MP3 et WMA

Glisser-déposer les fichiers sur l'unité FINIS Duo™,
une barre de progression apparait

pendant l'opération

. TELECHARGEMENT PAR WINDOWS

MEDIA PLAYER®:

Ouvrir la bibliotheque musicale Windows

Media Player

FINIS Duo™ drive apparait automatiquement dans
l'onglet de Synchronisation

Glisser-déposer les fichiers sur Uunité FINIS Duo™,
une barre de progression apparait

pendant l'opération

Appuyer « Commencer synchronisation » lorsque
vous étes préts

Le logiciel Windows Media Player crée un document
.xml pour tous les morceaux téléchargés. NE PAS
effacer le document .xml sauf si tous les morceaux
seront effacés

C. PIER POUR LES UTILISATEURS MAC®:

Ouvrir Uunité FINIS Duo™

Lieu : « Ecran principal »

Ouvrir tout directeur contenant des fichiers au
format MP3 et WMA

Glisser-déposer les fichiers sur l'unité FINIS Duo™,
une barre de progression apparait

pendant l'opération
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COMMENT UTILISER: FICHIERS AUDIO COMPATIBLES

COMMENT UTILISER: ENLEVEMENT EN SECURITE

COM

Fichiers MP3 et WMA sans protection

Les fichiers AAC et les fichiers AAC achetés doivent
étre transformés en fichiers MP3

Pour des instructions détaillées sur la
transformation des fichiers en format MP3, accéder
www.FINISinc.com/Duo™

Les fichiers Audio book doivent étre sous forme MP3

MENT UTILISER:

FICHIERS AUDIO INCOMPATIBLES

IMPO

Les fichiers protégés : MP3, AAC et WMA
sont incompatibles

Les téléchargements Audible® book
sont incompatibles

RTANT: PREVENTION DES FICHIERS ENDOMMAGES

Les fichiers MP3 doivent excéder les 1000 Ko

Les fichiers natifs doivent étre transférés a partir du

périphérique de stockage ou d'un logiciel de gestion de

contenu multimédia (ne pas transférer de raccourcis
chansons)

e Anoter: Le transfert de fichiers dont le format n’est
pas pris en charge peut conduire au gel de l'appareil,
au déchargement de la batterie ou a une réduction de
la longévit

A.

POUR LES UTILISATEURS WINDOWS®:
e Localiser l'unité FINIS Duo™

e Lieu: « Mon Ordinateur »

o Cliquer droit et choisir « Ejecter »

.POUR LES UTILISATEURS MAC®:

e Localiser l'unité FINIS Duo™

e Lieu : « Ecran principal »

e Glisser-déposer le symbole de U'unité FINIS Duo™
de l'écran principal vers la poubelle ou Ctrl+clic et
choisir Ejecter « FINIS Duo™ »
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COMMENT UTILISER: CONVERSION TYPE DE FICHIER

A. Ouvrez les Préférences d'iTunes. Note: Les chansons acquises précédemment sont codées
e Sous Windows : Choisissez Modifier Préférences. au format protégé AAC qui ne permet pas leur conversion.
e Sous Mac : Choisissez iTunes > Préférences Pour convertir ces chansons dans un autre format,
rendez-vous sur le site:
B. Cliquez sur le bouton Général, puis cliquez sur le https://support.apple.com/en-us/HT201616
bouton Importation des parameétres... en bas de
la fenétre La chanson au format original et la nouvelle chanson

convertie figurent dans votre bibliotheque
C. A partir du menu contextuel Importation actifs,
choisissez le format de codage MP3, puis cliquez sur Informations provenant du site:
OK pour enregistrer les paramétres https://support.apple.com/en-gb/HT204310

D. Sélectionnez une ou plusieurs chansons dans votre
bibliothéque, faites un clic droit ou a partir du menu
Dossier > Créer une nouvelle version, choisissez un
des éléments suivants (U'élément du menu change pour
indiquer ce qui est sélectionné dans votre Importation
de préférences):

e Créer une version MP3

70 71



INSTRUCTIONS DENTRETIEN

CONDITIONS DE SYSTEME

Duo™ est imperméable jusqu'a 3 métres - utilisation
sans risque en piscines, lacs, océans ou autres
étendues d'eau

Rincer a l'eau fraiche aprés chaque utilisation
Sécher et ranger dans un endroit sec et frais

Ne pas sécher a la lumiére du soleil pour éviter
d’endommager le dispositif

Ne pas utiliser des objets aigus, tel que les ongles,
pour appuyer sur les boutons, pour éviter de
perforer la surface et provoquer des dégats par
Uinfiltration de l'eau

Ne pas essayer de charger ou de connecter le
dispositif mouillé, le dock USB Magnétique n’est pas
imperméable

Recommandation : Maintenir les fiches de
chargements propres en utilisant un coton-tige
imbibé en alcool

IMPORTANT! Entretien courant
A. Apres chaque utilisation, rincer a 'eau douce, sécher en
tamponnant et conserver dans un endroit frais et sec

B. Nettoyer les connecteurs en plaqué or situés a arriere de
l'appareil en utilisant un coton-tige ou une brosse a dent et

de l'alcool isopropylique

a. A noter: Omettre de sécher et de nettoyer l'appareil

régulierement peut engendrer une corrosion pouvant

compromettre son fonctionnement

e Pentium® Il 500 MHz ou supérieur recommandé
e Windows XP® (service pack 1 ou supérieur] ou

¢ Windows Vista® Windows 7®

e Windows 8®

e Mac®0S9X ou supérieur

e 250 MO d’espace disponible sur le disque dur

e 128 MO RAM (256 recommandé)

e Connexion USB (2.0 recommandé)

e Accés Internet (recommandé)

e Carte de son (recommandé)
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GARANTIE

Garantie limitée d'un an : Le lecteur MP3 subaquatique
Duo™ est garanti par FINIS en ce qui concerne les
défauts de matériaux ou de fabrication, en conditions
normales d’utilisation, pendant 1 an aprés la date d'achat
du dispositif original. La garantie limitée n'inclut pas

les dommages provoqués par l'utilisation inadéquate,

les accidents, les modifications, les réparations non-
autorisées, l'usure normale ou par d'autres causes qui ne
constituent pas de défauts de matériaux ou de fabrication.
En cas de défaut caché, le produit sera réparé ou remplacé
sans frais supplémentaires ou bien remboursé a la
discrétion de FINIS. Preuve d'achat requise.

Veuillez visiter www.FINISinc.com/support pour
plus d’informations.
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CONTENUTO PULSANTI

A. Lettore MP3 subacqueo Duo™ A. Accensione/Spegnimento/Riproduzione/Pausa
B. Dock magnetico USB B. Ripetizione brano/Indietro/Aumento volume

C. Guida rapida C. Avanti/Riduzione volume

D. Attivazione riproduzione casuale/Disattivazione
riproduzione casuale

4 1 Dy
S =

<

(]

duo

UNDERWATER MP3 PLAYER B
WITH BONE CONDUCTION AUDIO -

d

QUICKSTART GUIDE
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MODO D'INSERIMENTO

A. Individuare (lato sinistro) e (lato destro) sul retro di ogni
altoparlante per posizionarli correttamente

Duo™ offre un sonoro ottimale sottacqua o indossando
tappi per le orecchie per bloccare il rumore ambientale

B. Far scorrere le cinghiette degli occhialini attraverso i
fermagli su entrambi i lati

C. Per ottenere una nitidezza ottimale appoggiare gli
altoparlanti a conduzione ossea sulle tempie, non
sulle orecchie
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MODO D"USO: RIPRODUZIONE MUSICA

A. ACCENSIONE/SPEGNIMENTO

Per accendere Duo™: Tenere premuto il pulsante
centrale per 3 secondi. La luce fissa VERDE indica
che la riproduzione iniziera tra 10 secondi

Per spegnere Duo™: Tenere premuto il pulsante
centrale per 3 secondi. La luce lampeggiante VERDE
indica che il dispositivo si sta spegnendo

B. RIPRODUZIONE/PAUSA

Per RIPRODURRE la musica: Premere una volta il
pulsante centrale

| brani saranno riprodotti sequendo l'ordine in cui
sono stati caricati dal computer

Durante la riproduzione la luce VERDE lampeggia
ogni 3 secondi

Per mettere in PAUSA la musica: Premere una volta
il pulsante centrale

In modalita pausa, la luce VERDE lampeggia due
volte ogni 3 secondi

C. AVANTI/RIDUZIONE VOLUME

Per andare AVANTI: Premere una volta il pulsante
per riprodurre il brano successivo

RIDUZIONE VOLUME: Tenere premuto il pulsante
per abbassare il volume

La luce VERDE lampeggera mentre si abbassa

il volume, fino al rilascio del pulsante e al
raggiungimento del volume desiderato

D. RIPETIZIONE/INDIETRO/AUMENTO VOLUME

Per RIPETERE il brano: Premere una volta il
pulsante

Per andare INDIETRO: Premere due volte il pulsante
per riprodurre il brano precedente

AUMENTO VOLUME: Tenere premuto il pulsante per
aumentare il volume

La luce VERDE lampeggera mentre si aumenta

il volume, fino al rilascio del pulsante e al
raggiungimento del volume desiderato

E. RIPRODUZIONE CASUALE

Per attivare la riproduzione casuale: Tenere premuto
il pulsante . La luce fissa VERDE apparira per 1
secondo per indicare che la modalita Riproduzione
casuale e attivata

Per disattivare la riproduzione casuale: Tenere
premuto il pulsante. La luce lampeggiante VERDE
indica che la modalita Riproduzione casuale e
disattivata
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MODO D"USO: CARICAMENTO

e Duo™ impiega 3 ore per caricarsi completamente*

e La batteria dura fino a 7 ore di riproduzione, secondo
le impostazioni e il volume utilizzato

e Per CARICARE: Per prima cosa, localizzare i
connettori dorati sul retro dell’altoparlante
(lato sinistro)

e Allineare i connettori con i pin sul dock
magnetico USB

e Collegare direttamente l'USB nella porta USB del
computer (questo riconoscera automaticamente il
dispositivo)

A. La luce lampeggiante VERDE indica che il dispositivo e
in carica (3 ore per caricarsi completamente)

B. La luce fissa VERDE indica che il dispositivo e
completamente carico

C. La luce ROSSA indica che la batteria & scarica**
* Tenere in carica Duo™ per 24 ore prima del

primo utilizzo
** Si spegnera automaticamente se la batteria & esaurita
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MODO D"USO: CARICAMENTO DEI BRANI

La capacita di archiviazione & di 4 GB [circa

1.000 brani)

Collegare direttamente 'USB alla porta USB del
computer (questo riconoscera automaticamente il
dispositivo)

Per verificare che tutti i brani desiderati sono stati
caricati, aprire U'unita FINIS Duo™

| file audio non supportati dall'unita FINIS Duo™ non
saranno riprodotti dal dispositivo

Per ELIMINARE dei brani, aprire l'unita FINIS
Duo™ ed eliminare il brano desiderato cliccando o
premendo il tasto “Canc” sulla tastiera

A. CARICAMENTO PER UTENTI WINDOWS®:

Aprire Uunita FINIS Duo™

Posizione: "Computer”

Aprire la cartella sul vostro computer che contiene i
file in formato musicale MP3 0 WMA

Trascinare i file nell'unita FINIS Duo™. Apparira una
barra di stato per indicare l'avanzamento

del trasferimento

B. CARICAMENTO ATTRAVERSO WINDOWS
MEDIA PLAYER®:

Aprire la libreria musicale di Windows Media Player
L'unita FINIS Duo™ sara riconosciuta
automaticamente nella scheda “Sincronizza”
Trascinare i file musicali nell'unita FINIS

Duo™. Apparira una barra di stato per indicare
l'avanzamento del trasferimento

Premere “Avvia sincronizzazione” quando si & pronti
al caricamento

Dopo il caricamento con Windows Media Player
comparira un documento .xml per tutti i brani
caricati. Non eliminare il documento .xml a meno
che non si rimuovano tutti i brani dal lettore

C. CARICAMENTO PER UTENTI MAC®:

Aprire Uunita FINIS Duo™

Posizione: “Desktop”

Aprire la cartella sul vostro computer che contiene i
file in formato musicale MP3 0 WMA

Trascinare i file nell'unita FINIS Duo™. Apparira
una barra di stato per indicare 'lavanzamento del
caricamento
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MODO D"USO: FORMATI AUDIO SUPPORTATI

MODO D"USO: RIMOZIONE SICURA

File MP3 e WMA non protetti

File AAC e AAC acquistati devono essere convertiti in
formato MP3

Per istruzioni dettagliate sulla conversione dei file
in formato MP3, visitare il sito www.FINISinc.com/
Duo™

Audiolibri devono essere in formato MP3

MODO DUSO: FORMATI AUDIO NON SUPPORTATI

Protetti: MP3, AAC e WMA non sono supportati
o riproducibili

Libri Audible® scaricati non sono supportati

o riproducibili

IMPORTANTE: PREVENZIONE DELLA CORRUZIONE
DELLA CARTELLA
Le cartelle MP3 devono essere superiori a 1000 KB

e E necessario caricare le cartelle native da un dispositivo

di memorizzazione od un software per la gestione dei
media (non caricare i brani shortcut)

Si prega di notare: Caricare cartelle non supportate

pud portare al congelamento dell” unita,

all'esaurimento della batteria od ad una diminuzione

della durata della vita del dispositivo

A.

PER UTENTI WINDOWS®:

Localizzare l'unita FINIS Duo™.
Posizione: “Computer”

Fare clic con il pulsante destro e
selezionare “Espelli”

.PER UTENTI MAC®:

Localizzare l'unita FINIS Duo™.

Posizione: “Desktop”

Trascinare licona dell'unita FINIS Duo™ dal desktop
al Cestino, oppure premere Ctrl+clic e selezionare
Espelli “FINIS Duo™”
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MODO D"USO: CONVERSIONE TIPO DI FILE

A. Aprire Preferenze di iTunes.
e Windows: Selezionare Modifica> Preferenze.
e Mac: Selezionare iTunes> Preferenze

B. Fare clic sul pulsante Generale, quindi fare clic sul
pulsante Impostazioni Importazione ... nella sezione
inferiore della finestra

C. Dal menu pop-up Importa Usando, selezionare il
formato di codifica MP3, quindi fare clic su OK per
salvare le impostazioni

D. Selezionare uno o pit brani nella libreria, fate clic
destro o dal menu Cartella> Creare Nuova Versione,

scegliere uno dei seguenti (le modifiche degli articoli
del menu per mostrare cio che e stato selezionato nelle

preferenze di importazione)
e Creaversione MP3

Nota: | brani piu vecchi acquistati sono codificate
utilizzando un formato AAC Protetto che li impedisce

di essere convertiti. Per convertirli in un altro formato,

visitare: https://support.apple.com/en-us/HT201616

Il brano nel formato originale e la canzone appena
convertita appaiono nella libreria

Informazioni ottenute da:
https://support.apple.com/en-gb/HT204310
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MANUTENZIONE

REQUISITI DI SISTEMA

Duo™ e resistente all'acqua fino a 3 metri di
profondita - puo essere utilizzato in piscine, laghi,
oceani e qualsiasi bacino d'acqua

Sciacquare con acqua fresca dopo l'utilizzo
Asciugare tamponando e conservare in un ambiente
asciutto e fresco

Non esporre alla luce diretta del sole per farlo
asciugare, perché potrebbe danneggiarsi

Non usare oggetti affilati, come le unghie delle

dita, per premere i pulsanti, poiché la superficie di
questi potrebbe forarsi e causare danni per via della
penetrazione dell'acqua

Non provare a caricarlo o collegarlo mentre e
bagnato, il dock magnetico USB non e impermeabile
Si raccomanda di mantenere i pin di ricarica puliti
con un bastoncino di cotone e alcool

IMPORTANTE! Manutenzione di routine

A. Dopo ogni utilizzo, sciacquare con acqua fresca, asciugare

B.

e conservare in un ambiente fresco ed asciutto

Pulire connettori dorati sul retro del dispositivo utilizzando

un batuffolo di cotone o spazzolino ed alcool

a. Si prega di notare: Se il dispositivo non viene
asciugato e pulito regolarmente puo portare alla
corrosione, che potrebbe comprometterne
la funzionalita

e Pentium®lIll 500 MHz o superiore consigliato
¢ Windows XP®(service pack 1 o superiore) o
e Windows Vista®Windows 7®

¢ Windows 8®

e Mac®0S9X o superiore

e 250 MB di spazio disponibile sul disco rigido
e 128 MB di RAM (256 consigliati)

e Porta USB (2.0 consigliata)

e Accesso a Internet (consigliato)

e Scheda audio (consigliata)
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GARANLZIA

Garanzia limitata di un anno: FINIS garantisce che

il Lettore MP3 Subacqueo Duo™ e privo di difetti nei
materiali e nella fabbricazione, in condizioni normali di
utilizzo, per un periodo di 1 anno dalla data di acquisto
iniziale. La garanzia limitata esclude danni derivanti
da uso improprio, incidenti, alterazioni, riparazioni non
autorizzate, normale usura d’'uso o altre cause che
esulano dai difetti nei materiali e nella fabbricazione.
Qualora sia presente un difetto coperto dalla garanzia,
provvederemo a riparare o sostituire il prodotto
gratuitamente o a emettere un rimborso, a discrezione di
FINIS.

Per ulteriori informazioni visitare il sito
www.FINISinc.com/support.
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INCLUIDO BOTOES

A. Duo™ Underwater Leitor de MP3 A. Ligar/Desligar/Reproduzir/Parar
B. Cabo USB B. Repeticdo da Misica/Retroceder/Subir Volume
C. Guia de comeco rapido C. Avancar/Baixar Volume

D. Tocar Aleatério Ligado/Tocar Aleatério Desligado
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COMO USAR

A. Use (do lado esquerdo) e (do lado direito) na parte de 0 Duo™ apresenta uma melhor audicdo dentro de agua
tras dos auscultadores para orientar de forma correta ou com auscultadores de forma a bloquear o ruido

atmosférico

B. Deslize as tiras de proteccao através dos suportes de
cada lado

C. Coloque a estrutura de conducao dos auscultadores
a descansar na estrutura central, ndo sobre a orelha,
para obter uma claridade dptima
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COMO USAR: TOCAR MUSICA

A. LIGADO/DESLIGADO

Para Ligar o Duo™: Carregue e mantenha premido

o botao durante 3 segundos. A luz VERDE quando
estabiliza, indica que o som ird comecar dentro de
10 segundos

Para DESLIGAR o Duo™: Carregue e mantenha
premido o botdo durante 3 segundos. O piscar da luz
verde indica que o aparelho ird desligar-se

B. REPRODUZIR/PARAR

Para REPRODUZIR a musica: Carregue uma vez no
botao

As musicas irdo tocar na ordem cuja qual foram
carregadas do computador

Enquanto toca, a luz verde pisca duas vezes cada

3 segundos

Para PARAR a musica: Carrega uma vez no botdo
Enquanto parado, a luz verde ira piscar durante

3 vezes

C. AVANCAR/BAIXAR VOLUME

Para AVANCAR: Carregue uma vez no botao para
avancar para a proxima musica(s)

Para BAIXAR O VOLUME: Carregue e mantenha
premido o botao para baixar o volume

A luz VERDE ira piscar enquanto baixa o volume,
até ao momento em que soltar o botdo atingindo o
volume desejado

D. REPETIR/VOLTAR PARA TRAS/SUBIR VOLUME

Para REPETIR a musica atual: Carregue uma vez

no botao

Para VOLTAR PARA TRAS: Carregue duas vezes no
botdo para reproduzir a musicals) anterior(es).
Para SUBIR VOLUME: Carregue e mantenha premido
o botdo para subir o volume

A luz VERDE ira piscar enquanto sobe o volume, até
ao momento em que soltar o botdo atingindo o
volume desejado

E. REPRODUZIR ALEATORIO

Para ligar o modo de REPRODUCAQ ALEATORIO:
Carregue e mantenha premido o botdo. Ird aparecer
uma luz VERDE durante 1 segundo indicando que o
modo de Reproducao Aleatério encontra-se ligado
Para desligar o modo de REPRODUCAO ALEATORIO:
Carregue e mantenha premido o botao. O piscar

da luz VERDE indica que o modo de Reproducao
Aleatdria encontra-se DESLIGADO
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COMO USAR: CARREGAR

e O Duo™ demora 3 horas a carregar desde pouca A.
bateria até completo*

e 0 tempo de reproducdo dura até 7 horas, o que
dependera das definicoes e da intensidade de
volume utilizada

e Para CARREGAR: Primeiro localiza a entrada do
adaptador na parte de tras do auscultador (lado
esquerdo)

e Alinhe a entrada com os pins do cabo USB

e Ligue directamente o cabo USB ao seu computador
através de uma porta USB (o seu computador ira
reconhecer o aparelho automaticamente)

A. O piscar da luz verde indica que o aparelho encontra-se
a carregar (demora 3 horas a carregar completamente,
quando a bateria encontra-se sem qualquer carga)

B. Quando a luz VERDE ficar ligada permanentemente, o
aparelho encontra-se carregado

C. A luz VERMELHA indica que o aparelho tem
pouca bateria**

*Por favor, carregue o seu Duo™ 24 horas antes da sua

primeira utilizacao C.
**Quando esgotar a bateria, o aparelho desliga-se

automaticamente




COMO USAR: CARREGAR MUSICA

A capacidade de armazenamento é de 4GB (cerca de
1000 musicas)

Ligue directamente o cabo USB & porta USB do

seu computador (o seu computador ird reconhecer
automaticamente)

Confirme que todas as musicas desejadas que foram
carregadas abrindo o FINIS Duo™ drive

Qualquer ficheiro nao suportado no FINIS Duo™
drive nao sera reproduzido no aparelho

Para APAGAR as cancoes, abra o FINIS Duo™ drive e
remova as musicas desejadas, carregando no botao
direito do rato ou na tecla “delete” do teclado

A. CARREGAR PARA UTILIZADORES DO WINDOWS®:

Abra o FINIS Duo™ drive

Localizacdo: “Meu Computador”

Abra qualquer pasta que contenha musica nos
formatos MP3 e/ou WMA

Arraste e coloque os ficheiros de musica no FINIS
Duo™ drive, a barra de estado ird aparecer durante
o carregamento

B. CARREGAR ATRAVES DO WINDOWS
MEDIA PLAYER®:

Abra a Biblioteca de musica do Windows

Media Player

FINIS Duo™ drive ira aparecer automaticamente no
separador de Sincronizacao

Arraste e coloque os ficheiros de musica no FINIS
Duo™ drive, a barra de estado ird aparecer durante
0 carregamento

Carrega “Iniciar Sincronizacado” quando estiver
pronto para realizar o carregamento

Windows Media Player quando utilizado, ird criar um
documento .xml para todas as musicas que foram
carregadas. NAO apague o documento .xml a nao ser
que queira remover todas as musicas

C. CARREGAR PARA UTILIZADORES DE MAC®:

Abra o FINIS Duo™ Drive

Localizacdo: “Secretaria”

Abra qualquer pasta no seu computador que
contenha ficheiros de muisica nos formatos MP3
e/ou WMA

Arraste e coloque os ficheiros no FINIS Duo™ drive,
uma barra de estado ird aparecer durante

o carregamento
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COMO USAR: FICHEIROS AUDIO SUPORTADOS

COMO USAR: REMOVER COM SEGURANCA

e Ficheiros WMA e MP3 nao protegidos

e Ficheiros AAC e AAC adquiridos tém que ser
convertidos a ficheiros MP3

e Parainformacoes mais detalhadas de como
converter os ficheiros para formato MP3, visite
www.FINISinc.com/Duo™

e Ficheiros dudio de livros tém que ser no
formato MP3

COMO USAR: FICHEIROS AUDIO NAO SUPORTADOS

e Protegidos: MP3, AAC e WMA nao sao suportados
nem possiveis de reproduzir

¢ Downloads de livros Audible® nao sao suportados
nem possiveis de reproduzir

IMPORTANTE: PREVENCAO DE ARQUIVO CORROMPIDO
e Arquivos MP3 devem ser maiores do que 1000 KB
e Deve fazer o carregamento de arquivos nativos do
dispositivo de armazemamemto ou software de
gerenciamento de midia (ndo fazer o carregamento de
atalhos de musicas)

e Por favor, note: Carregamento de arquivos nao
suportados pode levar ao congelamento da unidade,
ao esgotamento da bateria ou diminuicao da vida Util
do dispositivo

A. PARA UTILIZADORES DO WINDOWS:

Localize o FINIS Duo™ drive
Localizacdo: "Meu Computador”
Carregue com o botao direito do rato e
seleccione “Ejetar”

B. PARA UTILIZADORES DO MAC®:

Localize o FINIS Duo™ drive

Localizagdo: “Secretaria”

Carregue e arraste o icone do FINIS Duo™ drive
para a secretaria no Lixo ou Ctrl+clique e seleccione
Ejetar “FINIS Duo™"
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COMO USAR: CONVERSAO DE TIPO DE ARQUIVO

A. Abra as Preferéncias do iTunes.
e Windows: Escolha Editar > Preferéncias.
e Mac: Escolha iTunes > Preferéncias

B. Clique no botao Geral, clique em Importar
Configuracodes ... botao na parte inferior da janela

C. A partir do Importar Usando o menu pop-up, escolha o
formato de codificacao de MP3, em seguida, clique OK
para salvar as configuracoes

D. Selecione uma ou mais musicas em sua biblioteca,
clique com o botao direito ou a partir do menu Arquivo
> Criar Nova Vers&o, escolha um dos seguintes (o item
do menu muda para mostrar o que esta selecionado
nas suas preferéncias de Importacdo):

e Criar versao MP3

Nota: Musicas compradas mais antigas sdo codificadas
usando o formato AAC Protegido, o qual impede que elas
sejam convertidas. Para converté-las em outro formato,
visite https://support.apple.com/en-us/HT201616

A musica no seu formato original e a musica recém
convertida aparecem em sua biblioteca

Informacdes provenientes de:
https://support.apple.com/en-gb/HT204310
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INSTRUCOES DE USO

REQUISITOS DO SISTEMA

Duo™ é a prova de dgua até os 3 metros de
profundidade - é seguro utiliza-lo em piscinas,
lagos, oceanos ou qualquer camada de agua

Passe por dgua potavel apds uso

Seque levemente, e reserve num local fresco e seco
Nao coloque o aparelho em contacto direto com a luz
solar, pois poderd causar algum dano

Nao use objetos afiados, tais como as unhas, para
premir os botdes uma vez que tal podera provocar
um furo e levar a dano, causado pela entrada

de agua

Nao tente carregar ou ligar enquanto o aparelho
estiver molhado, o cabo de USB nao é resistente

4 agua

Recomendado: Manter os pins na ficha de
carregamento limpos. Para tal aplique um algodao
suave demolhado em alcool etilico

IMPORTANTE! Manutencao de Rotina

A. Apos cada uso, lave com agua corrente, seque e armazene

em um ambiente fresco, seco

B. Limpar conectores dourados na parte de tras do dispositivo

usando um cotonete macio ou escova de dentes e alcool

a. Por favor, note: Falha em secar e limpar o dispositivo

regularmente pode levar a corrosao, o que pode
comprometer a funcionalidade

Pentium®I1l 500 MHz ou superior é recomendado
Windows XP®(pacote de servico ou 1 ou superior] ou
Windows Vista®Windows 7®

Windows 8®

Mac®0S9X ou superior

250 MB disponiveis no disco rigido

128 MB RAM (256 recomendado)

Porta USB (2.0 recomendado)

Acesso & internet (recomendado)

Cartao de Som (recomendado)

145



GARANTIA

Um Ano de Garantia Limitada: A garantia de que Duo™
Unbderwater MP3 é livre de qualquer defeitos de material
e acabamento, sobre o uso normal, é de 1 ano desde o
acto de compra, do aparelho original e é fornecida pela
FINIS. A garantia limitada exclui danos resultantes de uso
e manuseio improprio, acidentes, modificacoes, arranjos
nao autorizados, desgaste normal ou outras causas que
nao sao defeitos nos materiais e acabamentos. Se existir
um defeito que seja coberto pela garantia, iremos reparar
ou substituir o produto, isento de qualquer custo, ou entao
realizamos o reembolso & discricdao da FINIS. A prova de
compra é necessaria.

Por favor visite www.FINISinc.com/support para
mais informacoes.

duo

UNDERWATER MP3 PLAYER

WITH BONE CONDUCTION AUDIO

MHCTPYKLUMWA MO 3KCMNJYATALUU



BXOAMT B KOMIMNEKT

KHOMKWK

A. BopoHenpoHunuaembin MP3-nneep «Duo™»

B. MaruuTtHag gok-ctaHumusa, USB

C. MHcTpykums no akcnayaTauum

duo

UNDERWATER MP3 PLAYER
WITH BONE CONDUCTION AUDIO

d

QUICKSTART GUIDE
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A. Bkn./Bbikn./Bocnpownsseserune/lNaysa

B. MoBTop TekyLwen neCHM/I'IepeMOTKa Ha3agn/YBennyutb
rpoMKOCTb

C. MepeMoTka BNepéa/YMeHblWNTb FPOMKOCTb

D. Bknounts BocnponsseaeHue B ciay4anHoM nopsake/
BbikNtounTh BocnponsBeeHne B Cy4yallHOM nopsfke

A. / ,—\/\v C.
> -~ é

<
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KAKHOCUTb

A. Vicnonb3yite otMmeTky (nesas ctopoHa) v ( npasas JNlyywwe Bcero nneep cAbIWWM NOL BOAON UK C HAYLWIHUKAMMU
cTopoHa) c3aam Kax[oro AMHaMmuKa Ans nNpaBuabHOrO ANs 610KMPOBKM OKPYXKatoLLMX LLYMOB
pacnonoxeHus nneepa

B. MpocyHbTe peMeLlku 3aLnUTHBIX 04KOB Yepes
KpenieHns Ha KaXAoi CTopoHe

C. ina nonyyeHuns onTMManbHOM YETKOCTU 3BYKaA
pa3MecTuTe AUHAMWUKM HA BUCOYHOMN KOCTMW, HE Haf yXOM




KAK UCIOJIb30BATb:
BOCIMPON3BELEHNE MY3bIKM

A. BKJI./BbIKJI.

[ins BknoyeHnsa nneepa: HaxxmuTte v ygepxumBante
LLleHTpasibHYyt KHOMKY B TeuyeHue 3 CekyHA.
Hemuratowmit 3ENEHBIV nHankaTtop curhannsnpyet
0 TOM, 4TO BOCMpoOM3BefeHNe HayHeTcs Yepes 10
ceKkyHa

[nsa BbikntoyeHns nneepa: HaxmuTe u yaepxunsainTte
LleHTpasbHylo KHOMKY B TeuyeHue 3 CekyHA.
Muratownit BEJIEHBIV nhankatop curHanusmpyet o
TOM, 4YTO YyCTPOMCTBO ByAeT BbIKIHOYEHO

B. BOCMPOU3BEOEHUE/MAY3A

[Ons BOCMNPOU3BEAEHWUA My3biku: OpguH pas
HaXXMWTE Ha LeHTPaJIbHY KHOMKY

MecHn bynyT BOCMPOU3BOAUTLCS B NOPSAKe, B
KOTOPOM OHM BbINN 3arpyxeHbl C KOMMboTepa

Bo BpeMs BocnpousBefeHns Myssiku SEJIEHBIN
MHAWKATOP MUTaeT KaXAable 3 CEKYHAbI

[na octaHoBKM My3blkn: OAUH pa3 HaxxMuTe
LeHTpanbHyt KHOMKY

Bo naysbi 3EJIEHbIN WHANKATOP MUraeT ABaX bl
Kaxxgble 3 cekyHAbl

C. NEPEMOTKA BNEPE[/YMEHbLWMWUTb FPOMKOCTb

Ons MEPEMOTKW BNEPEA: OauH pas HaxmuTe
KHOMKY “BOCMpoOU3BecTV” A5l BOCMPOM3BEAEHUS
cnepyowent necku (nece)

Ona YMEHbLWEHWNA TPOMKOCTU: HaxmuTte 1
yAEpXnBanTe KHOMKY, 4TOObl yMEHbLINTL 3BYK
3ENEHbBIN unankatop bynet Murats Bo BpeMs
yMeHbLUEHWS 3ByKa [0 TeX Nop, Noka KHomMkKa
bynet HaxaTa

D. NOBTOPHOE BOCNPOU3BEAEHNA/OBEPATHOE
BOCMPOW3BEJAEHUE/YBENUYEHWUE TPOMKOCTHU

[lna noBTOpHOro BOCNPOU3BeAEHUS TEKYLLEN NECHM:
OAVH pas HaxXMuTe KHOMKY

[Ona OBPATHOIO BOCIMPOU3BELEHNA:

[lBaxabl HAXXMUTE KHOMKY, 4TO6bl BOCMPOW3BECTH
npeabiayuyio necHio(wm)

Ons YBEJIMYEHUA 3BYKA: Haxxmute u nogepxute
KHOMKY, 4TOObl YBENNYNTL FPOMKOCTb

3EJIEHbIN ceT ByaeT MuraTb BO BpeMs yBESIMYEHMS
3ByKa [0 Tex nop, noka He noayymTe HeobxoAnMbIi
YPOBEHb FPOMKOCTM U HE OTNYCTUTE KHOMKY

E. BOCMNPOW3BELEHWE NECEH B C/IYYAHOM
NoPALKE

[ina BocnpousBeneHns neceH B Cy4yaHoM nopsigke:
HaxmMunTte n ynepxvBante KHoNKy

Hemuratowmit 3EJIEHBIV nnankaTtop 3aroputcs Ha

1 cekyHAy, CUTHaNMU3NpPYys 0 BKIOYEHUW DYHKLMK
BOCMPOW3BELEHUS NEeCeH B Cy4aliHOM nopsifke

[lna oTMeHbl BOCNpoV3BeeHUs NeceH B Cy4aiiHOM
nopsinke: Haxmute v yaepxuBanTe KHOMKY.
Muratowmit 3ENEHBIV nhankatop curHanusmpyet

0 TOM, 4TO BOCMpPOM3BE[EeHNe NeceH B Cay4yaiiHoM
nopsifike BbIKIOYEHO
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KAK UCMOJIb30BATb: SAPAHLKA

e 3apsfka nneepa [0 NOJHOMO YPOBHS 3aHUMaeT A.
3 vaca*

e BpewMms Bocnpou3BefeHus [0 7 4acos, B 3aBUCHMMOCTH
OT HAacTPOeK U YPOBHS FPOMKOCTU

o [na MOOA3APALKWN: CHauyana Hangute coeguHUTENN
30/10TOrO0 LBeTa Ha 3afHel CTOPOHE N1eBOro JMHaMuKa

e CoBMecTWUTEe pa3beMbl C KOHTAKTAMUW Ha MarHUTHOWM
LOK-CTaHLMK

e Hanpsamyto nogkntoumTe ctaHuuio kK USB-nopty
Ha KoMnbloTepe (Baw koMnbloTep aBToMaTMYeCcKu
pacnosHaert yCTPOMCTBO)

A. Muratowuit 3ENEHBIV nHankaTtop curHannsnpyet o B.
3apsaake (3 yaca anga 3apsAKM 40 NOSHOTO ypoBHS)

B. Hemuratowuit S3EJIEHbIN ungukatop curHanusmupyet o
NOSIHOM YPOBHe 3apAaKM

C. KPACHbIV nupmnkaTop curHanusnpyeT o HU3KOM ypoBHe
3apapku**

*Moxanyncra, 3apsXaTe nieep B TeyeHue 24 yacoB nepep

nepBbIM UCMOb30BaHNEM

**[neep BbIKNOYNTCS aBTOMaTM4ecku, ecnun batapes

paspsiXeHa C.




KAK UCMOJIb30BATb: AT PY3KA MY3bIKI

06b&M namaTh 4 6 (okono 1000 neceH)

Hanpsimyto nogknoymnte gok-ctaHuymio kK USB-nopTy
Ha KoMmbloTepe (Baw KoMnbloTep aBToOMaTUYeCKH
pacnosHaeT yCTPOMCTBO)

MoaTBEPAMTE, UTO BCE HeObXOAMMbIE NECHM
3arpy>eHbl, OTKPbIB NPUBOLHOE YCTPONCTBO

FINIS Duo™

He nopnepxvBaeMble NPUBOLHBIM YCTPONCTBOM
aynunodannbl He byayT BOCNPON3BOLUTLCSA
YyCTPOMCTBOM

Y1obbl YOAJIUTD necHu, otkpoite guckosop FINIS
Duo™ u ypanute HeobxoanMble NecHU, Haxas Ha

npasyto KHOMKY MbILIK, MAK HaxXMuTe KHonky “delete”

Ha KnaBuaType

A. YCTAHOBKA /1 NO/Ib30BATEJIEA WINDOWS:

OTkpowte aunckosop FINIS Duo™

Pacnonoxexwe: “Moit koMmnbloTep”

Ha cBoeM koMnbloTepe 0TKPOTe Manky ¢ My3biKoi B
dopmate MP3 1 WMA

MepeTawmte My3bikanbHble Gaifibl B LUCKOBOA,
FINIS Duo™, Bo BpeMs 3arpy3ku nosButca Tabnunuka
cTaTyca

B. 3ATPY3KA YEPE3 NMPOUTPbIBATEJIb WINDOWS:

OTkpowTe My3blkanbHyto bubnuoteky MpourpbiBaTtens
Windows

Ouckosopg FINIS Duo™ aBToMaTMyeckn nosBUTCA B
Tabnuuke cUHXpoHU3aLUK

MepeTawmTte My3bikanbHble Ganfibl B UCKOBOA
FINIS Duo™, Bo Bpems 3arpy3ku nosiButcs Tabnunyka
cTaTyca

Haxmute “HayaTb cuHxpoHu3aymio”

Mpu ncnonbsosaHuu Mpourpeisatensa Windows
co3faeTcs JOKyMeHT .xml ANns Bcex 3arpy>eHHbIX
neceH. He yganainTte jokyMeHT .xml, ecnu He
yAansiete BCe NeCHM

. 3ATPY3KA [J19 NOJIb30BATEJIEN MAC:

OTkpownTte guckosop FINIS Duo™

Pacnonoxexue: “MaHenb skpaHa”

Ha koMnbtoTepe oTkpolTe ntobyto Nnanky ¢ My3blikol B
dopmate MP3 n WMA

MepeTtawmte B guckoson FINIS Duo™, Bo Bpems
3arpy3ku nosButcs Tabanyka cratyca
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KAK UCIOJIb30BATb:
NOOJAEPXUBAET AYOVOQANITHI

KAK UCMOJIb30BATb:
BE3OMNACHOE N3BJIEYEHNE

e HesawwnweHHble dannsl MP3 1 WMA

e AAC u npuobpeteHHble dpannbl AAC fomKHbI bbITh
nepesefieHbl B dopmaTt MP3

e CMoTpuTe NoapobHylo MHCTPYKLMIO O TOM, Kak
nepesectu ¢annbl B opmat MP3:
www.FINISinc.com/Duo™

e Daiinbl ayANoKHUT JONXKHbI 6bITb B dopMaTe MP3

KAK UCIOJIb30BATb:
HENOAOEPXMBAEMBIE AYANO0 QAN

e 3auwmuieHHbie: MP3, AAC 1 WMA He
NoALEPXKNBAIOTCA M HE NPOUTPbIBAOTCS.

e 3BykoBble daitnbl ayanokHur (Audible®) He
NoAAEPXKMBAKTCA U HE BOCTIPOU3BOAATCS

BAXHO: 3ALLUTA OT NOPYN ®ANIIOB
e Pasmep daiinos MP3 gonxeH 6biTh bonee 1000 KB
e Heobxopgnmo 3arpyxaTb ¢dalnbl B UCXOLHOM dpopmMaTe

13 ycTporcTBa xpaHeHus nnv npu nomowm MO gna

ynpasieHus Meanatekon (He 3arpyxaiTe apribiku

nece)

e BHuMaHue: 3arpyska HenoggepXnBaeMblx
bopmMaToB MOXET NPUBECTU K 3aBUCAHWIO
ycTponcTBa, paspagy batapeu nam cokpaweHuio
cpoka cnybbl ycTpoiicTBa

A. N9 NOJIb30OBATENEN WINDOWS:

Hanaute auckosop FINIS Duo™
Pacnonoxenue: “Moi komnbloTep”
LLlenkHuTe npasoit kHonkoW U BbiGepuTe “U3Bneub”

B. 4J1A1 NOJIb30OBATEJIEN MAC:

Hangute auckoson FINIS Duo™

Pacnonoxexue: “MaHenb skpaHa”

MepeTawmTe nkoHky guckosoga FINIS Duo™

c naHenu akpaHa B Kop3uHy uam c noMoLbio
koMbuHaumm Ctrl+kHonka Mbiwn BbibepuTe n3BneYb
“FINIS Duo™”
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KAK UCIOJIb30BATb:
MPEOBPASOBAHUE TUM GANIIA

A. OTkpoiiTe MeHto HacTpoiikn (Preferences) B iTunes.
¢ Windows: Buibepute Pegaktuposats (Edit) >
Hactpoiiku (Preferences)
e Mac: Boibepute iTunes > Hactpoiiku (Preferences)

B. HaxwmwnTe Ha kHonky O6wue (General), 3aTem Ha
HacTtpoiiku nmnopta (Importing Settings)... B HuxHel
4acTn oKkHa

C. M3 Boinagatwouwero cnvcka Mmnoptep (Import Using)
Bbibepute dpopmaTt MP3, 3aTeM Haxxmute Ha OK pns
COXpaHeHUs HacTpoek

D. BuibepuTe ofHYy MAn HeCKoNbKO NeceH B Ballen
MefuaTeke, 3aTeM MpU MOMOLLU NPABON KHOMKM MblLUN
nnu n3 menio ®ain (File) > Cozgatb HoBylo Bepcuio
(Create New Version) Bbi6epuTe ogunH 13 cnegytoune
BapnaHToB (MYHKT MEHI0 MEHAETCS B 3aBUCMMOCTM OT
BalLMX HAaCTpoeK uMnopTal:

e Co3paTb Bepcuto 8 MP3

MpnMeyaHue: MNecHu, npnobpeTeHHble paHee, KOAMpyeTCs
npu noMoLn cneumnanoHoro popmata AAC, KoTopbIn
3alWuMLaeT ux oT KOHBepTUMpoBaHua. [ins Toro, 4TobbI
CKOHBEpPTMpOBaTb Tpeku B apyron dopmat, nepenpnte no
cnepyloLen ceblsike:
https://support.apple.com/en-us/HT201616.

[MecHa B opurnHanbHoM dopMaTte ¥ CKOHBEPTUPOBAHHbIN
BapuaHT NoABSATCH B Balleil MeanaTeke

NcTouyHnk nuHdopmaymm:
https://support.apple.com/en-gb/HT204310
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WHCTPYKL WK NO YXOoy

CUCTEMHbIE TPEBOBAHUA

Mneep Duo™ saBnsieTcs BOAOHENPOHULAEMbIM

Ha rnybuHe go 3 meTpoB - be3onaceH gns
MCcnonb3o0BaHUS B NaBaTeNibHbIX bacceiHax, o3épax,
okeaHax unu B Nto6oM Lpyrom BojoémMe

[MpomoWTe YncToN BOAON Nocsie MCNONb30BaHUA
AkKypaTHO 06CylIUTe U XpaHWUTE B MPOXSIaiHOM,
CYyXOM MecTe

He ocTaBnaiTe nof NpsiMbIMU CONTHEYHBIMMU

slydamu Ons CYLIKK, TaK Kak 3TO MOXET MPUBECTU K
NoBpexXaeHNto

He vcnonb3yiiTe ocTpble NpeAMeThl, Takne Kak
HOITK, ANA HaXaTus KHOMOK - TaK MOXHO MPOKO0Th
NOBEPXHOCTb, YTO NPUBELET K MOBPEXAEHUAM
BC/eACTBUE KOHTaKTa C BOLOM

He nbiTaiTech 3apsXaTb Uv NofgKa4YaTh BO
BlaXKHOM BUAe, Tak Kak MarHUTHas A0K-CTaHUWA He
ABNseTCs BOAOHENPOHULLAeMOM

PekoMeHpauuu: nopaepxvBanTe 3apsaaHble KOHTaKTbI
B YMCTOTE C MOMOLLbI MATKOW BaTHOW Nanoyku

u cnupTa

BAXXHO! PerynsapHoe obcnyxuBaHue
A. Tocne Kax/Aoro UCNosb30BaHNA OMOSOCHUTE NMUTLEBOA

BOLOW, 060TpVITe HacyXo U XpaHuUTe B MpoxaagHOM U CYyXOM

MecTe
B. OyncTtute 3010Tble COEANHUTENN Ha 3a4HEN CTOpOoHe

YyCTpPOMCTBa MATKON xaon4yaTobyMa>kHou Tpsinkon nam 3ybHown

LLeTKOW C MPOTUPOYHBIM CMINMPTOM

a. BHumMaHve: Ecnun He oumnwatb 1 He obTupaTth
YCTPOMCTBO Ha perynspHoi ocHoBe, OHO byaeT
nofBEP>KEHO KOPPO3MW, YTO HEraTUBHO MOBAUSET Ha
ero pyHKLMOHaNbHOCTb

e PekomeHpyeTtca Pentium |11 500 MIy nnu Beiwe

e Windows XP (naket ycnyr 1 unu Bbiwe)

e Windows Vista®Windows 7®

e Windows 8®

e Mac®0S9X nnu Bbiwe

e 0b6beM UMeloLLenca NaMaTh Ha XKECTKOM
nncke 250 M6

e 03Y 128 M6 (pekomeHayeTcs 256)

e [opt USB (pekoMeHayeTtca 2.0)

e [loctyn B MHTepHeT (pekoMeHpyeTcs)

e 3BykoBas kapTa (pekoMeHayeTcs)

163



FAPAHTHU

OfVWH rof, orpaHUMYeHHOW rapaHTUn: BOAOHENPOHMULAEMbIN
MP3-nneep «Duo™» 3awuuieH rapaHtunen FINIS

OT NMPOU3BOACTBEHHbIX flepeKkTOB NpU HaAsexallen
aKcnayaTauuu Ha nepwmof 1 rog ¢ fatbl NOKynKku
dupmMeHHoro yctpoictea . OrpaHuyeHHas rapaHTus

He pacnpocTpaHseTcs Ha NOBPEXAeHUS B pe3ysbTaTe
HenpaBW/IbHOrO YX0Aa Npu obpalleHnn, HecHacTHbIX
c/ly4yaeB, U3MEHEHUN, HECAaHKLMOHMPOBAHHOIO PEMOHTA,
HOPMabHOro U3HOCA UKW APYrUX NPUUYUH, KOTOPbIe

He ABNAOTCH NPOU3BOACTBEHHbIMU AedekTamu. MMpu
HanMumMm cKpbIToro aedekta Mbl OTPEMOHTUPYEM,

6ecniaTHO 3aMeHUM YCTPOMCTBO UK, MO YCMOTPEHUIO ™
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MANUAL DE INSTRUCCIONES




INCLUYE BOTONES

A. Reproductor de MP3 Duo sumergible A. Encendido/Apagado/Reproducir/Pausa

B. Adaptador USB magnético B. Reproducir nuevamente la pista actual/Retroceder/
Subir volumen

C. Guia de inicio rapido

C. Avanzar/Bajar volumen

D. Modo aleatorio encendido/Modo aleatorio apagado

A. / ,—\/\v C.
— RN —
< )
3
duo
AR P LR B D.
dJ

QUICKSTART GUIDE




COMO COLOCAR

A. Use (lado izquierdo) y (lado derecho) detras de cada Do funciona mejor si estda sumergido o con tapones para
auricular para identificarlos correctamente oidos para bloquear el ruido de ambiente

B. Deslice las tiras de las antiparras por los enganches de
cada lado

C. Ubique los auriculares apoyandolos sobre la sieny no
sobre las orejas, para una mejor calidad de sonido




COMO USAR: REPRODUCIR MUSICA

A. ENCENDIDO/APAGADO

Para ENCENDER Duo: Mantenga apretado el botdn
central durante 3 segundos. La luz VERDE fija indica
que la reproduccién comenzard en 10 segundos.
Para APAGAR Duo: Mantenga apretado el botdn
central durante 3 segundos. La luz VERDE que titila
indica que el dispositivo se esta apagando.

B. REPRODUCIR/PAUSA

Para REPRODUCIR musica: Presione una vez el
botdn central

Las pistas se reproducirdn en el orden en que fueron
cargadas desde su computadora

Mientras se reproduce la musica, la luz VERDE titila
cada 3 segundos

Para PAUSAR la musica: Presione una vez el

botén central

Mientras esta en pausa, la luz VERDE titila cada

3 segundos

C. AVANZAR/BAJAR VOLUMEN

Para AVANZAR: Presione una vez el botéon para
reproducir la siguiente pista

Para BAJAR EL VOLUMEN: Mantenga presionado el
botdn para bajar el volumen

La luz VERDE titilarad mientras baje el volumen,
hasta que suelte el botdn en el volumen deseado

D. REPRODUCIR/RETROCEDER/SUBIR VOLUMEN

Para REPRODUCIR NUEVAMENTE la pista actual:
Presione una vez el botdn

Para RETROCEDER: Presione dos veces el botén
para reproducir la pista anterior

Para SUBIR EL VOLUMEN: Mantenga presionado el
botén para subir el volumen

La luz VERDE titilard mientras suba el volumen,
hasta que suelte el boton en el volumen deseado

E. REPRODUCCION ALEATORIA

Para ACTIVAR el modo de reproduccidon aleatoria:
Mantenga presionado el boton. La luz VERDE fija
aparecerd durante 1 segundo para indicar que el
modo de reproduccidn aleatoria esta ACTIVADO
Para DESACTIVAR el modo de reproduccion
aleatoria: Mantenga presionado el botdn. La luz
VERDE que titila indica que el modo de reproduccion
aleatoria estda DESACTIVADO
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COMO USAR: CARGA

Dulo requiere 3 horas de carga para completar la
carga total*

El tiempo de reproduccién son hasta 7 horas,
dependiendo de la configuracién y el nivel de
volumen.

Para CARGAR: Primero, coloque los conectores
dorados en la parte trasera del auricular (lado
izquierdo)

Nivele los conectores con los pinches en el
adaptador USB magnético

Conecte directamente el USB en el puerto USB
de su computadora (su computadora reconocera
automaticamente el dispositivo)

A. La luz VERDE que titila indica que esta cargando
(requiere 3 horas para completar la carga total)

B. La luz VERDE fija indica carga completa

C. La luz ROJA indica bateria baja**

*Por favor, cargue Dlo durante 24 horas antes del
primer uso
** Se apagara automaticamente si la bateria se agota
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COMO USAR: CARGA DE MUSICA

La capacidad de almacenamiento es de 4GB
(aproximadamente 1000 pistas)

Conecte directamente el USB en el puerto USB

de su computadora (su computadora reconocera
automaticamente el dispositivo)

Confirme que todas las pistas deseadas se cargaron
abriendo el disco Duo FINIS

Cualquier archivo de audio no compatible en el disco
Ddo FINIS no se reproducira en el dispositivo

Para ELIMINAR pistas, abra el disco Dto FINIS y
elimine las pistas deseadas haciendo clic derecho o
presionando la tecla “eliminar” en el teclado

A. CARGA PARA USUARIOS DE WINDOWS®:

Abra el disco Dto FINIS

Ubicacién: "Equipo”

Abra cualquier carpeta en su computadora que
contenga los formatos MP3 y WMA

Arrastre y ubique los archivos de audio en el disco
Do FINIS, la barra de estado aparecerd mientras
se carga

B. CARGA A TRAVES DE WINDOWS MEDIA PLAYER®:

Abra la biblioteca de musica de Windows

Media Player

El disco Duo FINIS aparecerad automaticamente en la
pestafa de Sincronizacion

Arrastre y ubique los archivos de audio en el disco
Do FINIS, la barra de estado aparecerd mientras
se carga

Presione “Iniciar sincronizado” cuando esté listo
para cargar

Al usar Windows Media Player se creard un
documento .xml con todas las pistas cargadas. NO
elimine el documento .xml a menos que quiera
eliminar todas las pistas

C. CARGA PARA USUARIOS DE MAC®:

Abra el disco Dto FINIS

Ubicacién: “Escritorio”

Abra cualquier carpeta en su computadora que
contenga los formatos MP3 y WMA

Arrastre y ubique los archivos de audio en el disco
Do FINIS, la barra de estado aparecerd mientras
se carga
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COMO USAR: ARCHIVOS DE AUDIO COMPATIBLES COMO USAR: EXPULSION SEGURA

e Archivos MP3 y WMA no protegidos A. PARA USUARIOS DE WINDOWS®:
e Los archivos AAC y AAC comprados deben ser e Busque el disco Duo FINIS
convertidos a formato MP3 ¢ Ubicacion: "Equipo”
e Parainstrucciones detalladas de cdmo convertir ¢ Haga clic derecho y seleccione “Expulsar”
archivos a formato MP3, visite
www.FINISinc.com/Duo™ B. PARA USUARIOS DE MAC®:
e Los archivos de audio de libro deben estar en e Busque el disco Dio FINIS
formato MP3 e Ubicacion: “Escritorio”

e Arrastre y ubique el icono del disco Dto FINIS desde
el escritorio a la Papelera o presione Ctrl+clicy

COMO USAR: ARCHIVOS DE AUDIO NO COMPATIBLES seleccione Expulsar “Dio FINIS”

e Protegidos: MP3, AAC y WMA no son compatibles o
reproducibles

e Las descargas de libros de Audible® no son
compatibles o reproducibles

IMPORTANTE: EVITE DANO A LOS ARCHIVOS
e Los archivos MP3 deben ser mayores a 1000 KB
e Debe subir archivos originales del dispositivo de
almacenaje o software de gestiéon de medios (no
suba accesos directos de canciones])
e Tenga en cuenta: Subir archivos no admitidos
puede hacer que la unidad se congele, la bateria
se agote o la vida Util del dispositivo se reduzca
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COMO USAR: LA CONVERSION DE TIPO DE ARCHIVO

A. Abra las preferencias de iTunes. Nota: Las canciones viejas compradas son codificadas
e Windows: Seleccione Editar > Preferencias. utilizando un formato con extension .AAC Protegido que
e Mac: Seleccione iTunes > Preferencias evita que sean convertidas. Para convertir estas canciones
a otro formato, visite:
B. Presione el botdn General, luego presione el botén de https://support.apple.com/en-us/HT201616

los Ajustes de Importacion... que aparece en la parte
inferior de la ventana La cancién en su formato original y la cancion
recientemente convertida aparecen en su biblioteca
C. Desde Importes utilizando el mend desplegable,
seleccione el formato de codificacion MP3, luego haga Fuente de informacion:
clic en OK para guardar los ajustes https://support.apple.com/en-gb/HT204310

D. Seleccione una o mas canciones en su biblioteca,
presione el botén derecho o desde el menu de Archivo >
Crear Version Nueva, seleccione una de las siguientes
(el item del mend cambia para mostrar lo que esta
seleccionado en sus preferencias de importacién):

e Crea una version MP3
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INSTRUCCIONES DE CUIDADO

REQUISITOS DEL SISTEMA

Dlo es sumergible en el agua hasta 3 metros - apto
para usarse en piscinas, lagos, océanos o cualquier
tipo de medio acuatico

Enjuaguelo con agua limpia después de usarlo
Séquelo y guardelo en ambiente fresco y seco

No lo seque directamente al sol porque

podria dafnarlo

No use objetos puntiagudos, como sus ufas,

para pulsar los botones porque podria perforar al
superficie y eso haria que el agua lo dane

No intente cargarlo o conectarlo mientras esté
mojado, el adaptador USB magnético no es a prueba
de agua

Recomendacion: Mantenga los pinches de carga
limpios usando un hisopo de algoddn suave y alcohol

IMPORTANTE! Mantenimiento cotidiano

A. Luego de cada uso, enjuague con agua fresca, seque con
cuidado y almacene en un sitio fresco y seco

B. Limpie los conectores dorados sobre el dorso del
dispositivo utilizando un hisopo de algoddn suave o un
cepillo de dientes y alcohol etilico

a. Tenga en cuenta: No secar y limpiar el dispositivo
habitualmente puede conllevar a su corrosion, que
puede afectar la funcionalidad del mismo

e Serecomienda Pentium®IIl 500 MHz o superior
e Windows Xp®(paquete de servicio 1 o superior] o
e Windows Vista®Windows 7®

¢ Windows 8®

e Mac®0S9X o superior

e 250 MB de espacio disponible en el disco duro

e 128 MB RAM (256 recomendado)

e Puerto USB (2.0 recomendado)

e Acceso a internet (recomendado)

e Tarjeta de sonido (recomendado)
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GARANTIA

Garantia limitada de un ano: El reproductor de MP3 Duo
sumergible tiene garantia de FINIS, libre de defectos en
materiales de calidad, bajo uso normal, durante 1 ano

a partir de la fecha de compra del dispositivo original.
La garantia limitada excluye danos que resulten del
cuidado inapropiado al transportarse, de accidentes,
modificaciones, reparaciones no autorizadas, uso
convencional u otras causas que no correspondan a
defectos de material ni calidad. En caso de defectos de
fabrica, lo repararemos o reemplazaremos el producto
sin cargo, o emitiremos un reembolso segun el criterio de
FINIS. Se requerird comprobante de compra.

Por favor, visite www.FINISinc.com/support para
mas informacion.




